
 

 
Migrating AutoCAD Standards to Revit 
Douglas Bowers, AIA, LEED® AP – Doug Bowers Consulting, LLC   

CM1847  As you migrate to Revit from AutoCAD, there are always questions about how to make 
Revit output look like drawings produced by AutoCAD.  While Revit works differently than AutoCAD, 
there are also ways of configuring Revit to replicate some of the interface standards of AutoCAD.  The 
class will look at ways of modifying Revit Line Weights, Line Patterns, Line Patterns, Fill (Hatch) 
Patterns, Materials, Object Styles, and Units to help with the transition to Revit.  We will also look at 
migrating AutoCAD details into Revit and controlling AutoCAD line weights for AutoCAD linework that is 
linked into Revit.  Since there are some standards that will need to change with implementing Revit, this 
class will help you understand some of those items that should change. 

Learning	Objectives	
At the end of this class, you will be able to: 

 Customize Revit line weights to match their AutoCAD CTB table and replicating AutoCAD linetypes 
with text in them 

 Migrate their custom AutoCAD hatches to Revit fill patterns and modify Annotation Dimensions and 
text types in Revit 

 Configure views to have colors similar to AutoCAD layers 

 Migrate their standard details into Revit 

 

About	the	Speaker 

Doug Bowers has been a speaker at Autodesk University for multiple years and enjoys using 
his teaching and professional experience to make his classes both informative and enjoyable.  
He currently provides education and implementation services for Revit®, AutoCAD® 
Architecture, AutoCAD®, and Navisworks® and works extensively with designers and 
manufacturers in creating Revit® family content.  As an independent design software 
consultant and a registered architect, Doug Bowers combines over 30 years of 
architecture/engineering/construction (AEC) experience with over 20 years of experience in 
managing and/or consulting in the use of various design software packages. His unique 
combination of experience provides him insight into the needs of the various team members 
involved in the design and construction of a project, and the knowledge of how to apply 
technology to assist them. Doug is a LEED AP BD+C, holds various Autodesk certifications, 
and writes an AEC industry blog.  His past includes being a VAR Senior Consultant, Director of 
CAD Technology for a 16 office architectural firm, and the AEC Technical Editor for the AU 
Quarterly Newsletter. 

Doug@DougBowersConsulting.com 

Blog:  http://aectechtalk.wordpress.com 

Twitter:  @DBCdoug 
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Introduction	
Revit approaches project design and documentation differently than AutoCAD and users should 
not expect to use Revit in the same way as is done in AutoCAD.  This class is meant to help 
AutoCAD users migrate AutoCAD standards to Revit which do not negatively impact the way 
that Revit works.  Illustrations and discussions will focus on using the Imperial system, although 
everything can be adapted to the Metric system. 

In Revit, almost all of the standards are stored in the project template file, which is different than 
AutoCAD.  Therefore, most of the information discussed in this class can be made to the 
company’s project template file. 

Background	Color	
Revit utilizes a white background by default to simulate the appearance of a final printed sheet.  
Many AutoCAD users want to have a black background since that is what they have used in 
AutoCAD for years.  Revit allows you to have either a white background or a black background, 
but no other colors.  This setting has no impact on the output of the software. 

To change the default background color to black, go to the Application Menu and select the 
Options button from the bottom of the menu.  In the Options dialog box, select Graphics on 
the left side and place a checkmark next to the “Invert Background” option on the right side. 
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Establishing	Project	Units	
Like AutoCAD, Revit has default unit settings that get established for the project file.  Go to the 
Manage tab and select the Project Units function from the Settings panel.  Modify any of the 
settings that are required to get your desired appearance. 

A common setting to be modified is to remove the leading zero in a distance.  For instance, a 6” 
dimension is often more desirable than a 0’-6” dimension.  To remove a leading zero, select the 
Length format and then place a checkmark next to the “Suppress 0 Feet” option. 

 

Other Unit options that may be desired: 

 

Note that dimension types and schedules can have these formats overridden so that they 
display differently than the default settings established here. 

Revit MEP typically has more unit settings and unit symbols that are changed from the default 
than those in Revit Architecture. 
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Addressing	Line	Appearances	

Line	Weights	
In AutoCAD, line weights were specified by using either Color Table Based (CTB) or Style Table 
Based (STB) methods to determine how thick the lines would plot.  These files were stored 
somewhere on the computer and referenced during the plot process.  (The majority of 
companies using AutoCAD are utilizing customized CTB files to get the desired plot line 
thicknesses.)  Revit does not access external line thickness tables, but contains the line 
thickness parameters within each project file.   

The Line Weight settings inside Revit are accessed from the 
Manage tab, then the Additional Settings function on the 
Settings panel. 

 

 

 

 

 

 

 

A major difference between AutoCAD and Revit in dealing with line weights is how each of the 
software packages addresses various plot scales.  In Revit, model line weights automatically 
adjust thickness as the view scale changes; whereas, in AutoCAD you have to either manually 
or programmatically change the line thickness for different plot scales. 

Inside Revit, there are three different classifications for Line Weights: 

Model	Line	Weights	
This classification allows you to specify the line weight for modeled components in orthographic 
views.  These components include walls, doors, windows, plumbing fixtures, cabinetry, etc.  The 
line weight is adjusts according to the scale of the view and allows you to specify different 
widths for different scales. 

Perspective	Line	Weights	
This classification allows you to specify the line weight for modeled components in perspective 
views.  Since perspectives do not have actual scales, there is not the ability to have different 
line weights for different scales.  By default, all of these line weights are set the same as the 
1/8”=1’-0” scale on the Model Line Weights tab. 
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Annotation	Line	Weights	
This classification is for the annotation in the file, including notes, tags, labels, and dimensions.  
Almost all of the annotation objects are set to use Line Weight 1. 

The following illustration shows the default Model Line Weights in the Revit template files for 
various view scales.  (Note that the thickness format is based upon the Project Units setting.) 

 

To add an additional scale, pick the Add… button on the right side of the dialog box and select 
the desired scale.  Additional common scales are: 

 3” = 1’-0” 
 1 ½” = 1’-0” 
 ¾” = 1’-0” 

To adjust the line weight for a scale, simply pick the desired cell and type the desired line 
weight.  Many AutoCAD users have established their line weights based upon a specific plot 
scale.  For instance, they may want the Red color to print a specific thickness for a 1/8”=1’-0” 
scale drawing.  The best way to handle specifying the line weights is to go to the scale that most 
accurately represents your organization’s pen weights and adjust that scale first.  Print out a 
view using those line weights and analyze it to see if it appears as desired and then make any 
adjustments.  Each scale should then be analyzed and adjusted to get the desired thickness for 
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each line weight.  This can take a lot of time to go through each scale, but it is something that 
should be done.  This will likely also be adjusted over time to fine tune the settings. 

Note that only 16 different line weights can be specified for each scale; however, most users do 
not have a need for any more than that.  The Tri-Services Pen/Color Mappings standard even 
only specifies 8 different line weights.  The wider lines tend to be utilized for title blocks, 
presentations, and specialty purposes. 

Do not try to completely replicate the color to pen settings in AutoCAD with the line weights in 
Revit.  Revit uses objects to control appearance versus layers and colors.  Use the AutoCAD 
pen weights as a reference point in Revit and then refine your Revit settings from that point. 

Object	Styles	
As you set up your line weights, it is important to realize how they get assigned to object styles.  
The following image shows how line weights get assigned to different objects within a Revit 
project.  Note the Line Weight number adjacent to each of the various parts of a Door object and 
how you can have different weights associated to different parts.  The “Cut” column addresses 
any time that the view cuts through the object and the “Projection” addresses the remaining 
times when the object is not being cut.  (Note that floor plans by default cut through doors and 
other objects at 4’-0” above the floor.) 

 

(The above Object Styles dialog box is accessed via the Manage tab and the Object Styles 
button on the Settings panel.  Settings shown are the OOTB settings.) 

When establishing Line Weight pen widths in the Line Weights dialog box, coordinate those 
settings with the objects in the Object Styles dialog box to get the desired plot effect.  When 
setting the desired line weights, print each of the scales to see if they appear as desired.  You 
will also want to do this separately for plans, sections, elevations, and details for each scale. 

Additional Subcategories may be added by picking the New button at the bottom right corner of 
the Object Styles dialog box.  Appropriate line weights can be assigned to each of the new 
subcategories.  Subcategories are added so that they can be turned on/off and appearance 
controlled similar to an AutoCAD layer.  An example of an additional subcategory that may be 
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added includes “Clearance Zones” under the Doors, Electrical Equipment, and Mechanical 
Equipment categories. 

When AutoCAD drawings are linked into the project, the user can go to the Imported Objects 
tab and adjust the various settings for each layer in each linked AutoCAD file.  (Note that this 
only affects the settings in this project file and does not actually affect the AutoCAD file.) 

 

Line	Patterns	
Line Patterns are basically the same as AutoCAD Linetypes and specify the size and spacing of 
lines and spaces in a line. 

The following image shows some of the default Line Patterns in the Revit Architecture OOTB 
project templates.  This dialog box is opened by going to the Manage tab and selecting the 
Additional Settings button on the Settings panel and picking the Line Patterns option.  This 
image also shows the properties for the Dash line pattern after selecting the Edit… button. 
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If you desire to create a new line pattern that is similar to an AutoCAD linetype, pick the New 
button in the Line Patterns dialog box.  Enter the name of the line pattern (AutoCAD linetype) 
and enter information on each line as it is shown between commas in the AutoCAD linetype 
definition file.  The letter at the beginning of the line in the AutoCAD linetype file is ignored so 
you will start with the first number that you see. For the first number in the AutoCAD file, select 
the “Dash” option for the Revit properties then enter the numerical distance in the Value column.  
Spaces in AutoCAD linetypes are shown as a negative number in the file, so you will choose the 
“Space” option in the Revit properties and enter the numerical distance as a positive number in 
the Value column.  If Dots are desired in Revit, simply choose the “Dot” type instead of “Dash” 
and do not specify anything in the Value column. 

The following image shows creating a new Revit line pattern named “Border” to match the 
Border linetype in the OOTB AutoCAD acad.lin file provided with AutoCAD 2013. 

 

After creating new Line Patterns, assign them to the desired Line Style or Object Style.  The 
following image show the Border line pattern added to a newly created Border line style: 

 

 

 

Line	Styles	
Line Styles within Revit define the appearance of Model Lines and Detail Lines within a project 
file.  Model Lines are placed on work planes and can be seen in 3D views and applicable plan, 
elevation, and section views.  Detail Lines are 2 dimensional only and can only be seen in the 
view in which they are drawn.  When placing either model or detail lines, the user will choose 
the desired line type from those contained within the project file. 

Line Styles have four settings that make up its definition.  Those settings are the line style 
name, the line weight, the line pattern, and the color of the line. 
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The following is a list of the default line styles that are in the Architectural Template file.  New 
line styles can be created by selecting the New button at the bottom right of the dialog box.  
(New line styles created are only in the current project or template file in which they are 
created.) 

 

Users can create additional line styles for specific purposes and name as desired to make it 
clear as to the purpose of the line. 

An option for creating line styles is to utilize the National CAD Standards line weight settings.  
Those are: 

 Extra Fine 0.0051” 0.13mm 
 Fine 0.0071” 0.18mm 
 Thin 0.0098” 0.25mm 
 Medium 0.0138” 0.35mm 
 Wide 0.0197” 0.50mm 
 Extra Wide 0.0276” 0.70mm 
 XX Wide 0.0394” 1.00mm 
 XXX Wide 0.0551” 1.40mm 
 XXXX Wide 0.0787” 2.00mm 
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Lines	with	Text	
At this time, Revit does not allow you to have text as part of a line pattern, as is commonly done 
within AutoCAD.  Since this capability is not yet possible within Revit, we need to use 
workarounds to accomplish the same net results. 

A decent way to accomplish the same results is to create a family that creates lines with text.  
While this is not ideal, it typically achieves the same results.  There are some various methods 
of creating families to accomplish this task and have slightly different effects, although all use 
the same philosophy and appear pretty much the same in documentation.  Instead of outlining 
the process in this document, I have provided links to the various methods and encourage you 
to test each method to see which one most closely achieves your company’s desires. 

 http://www.cadapult.net/aecblog/2011/02/creating-complex-linetypes-in-revit/ 
 http://revitfamilies.blogspot.com/2007/02/text-value-line-styles.html 
 http://wikihelp.autodesk.com/Revit/enu/Community/Examples/Complex_(Text)_Line_Ty

pe 
 http://usa.autodesk.com/adsk/servlet/ps/dl/item?siteID=123112&id=9239235&linkID=92

43099 
 http://revitbasics.blogspot.com/2011/04/revit-line-based-families.html 

MEP	Piping	Lines	with	Text	
MEP users that desire to label piping do not need to utilize the above methods to accomplish 
their needs.  Revit includes an annotation tag that accomplishes this goal. 

Piping Systems have a parameter named System Abbreviation which can have the text 
abbreviation placed in it that the user desires to have displayed on the line representing the 
piping system.  Use the Tag function of Revit to tag the piping system with the “Piping System 
Abbreviation Tag” family.  Place the tag anywhere along the pipe where you desire the text to 
appear. 
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To utilize the above abbreviation for the piping system, load the Piping System Abbreviation 
Tag from the Pipe folder under the Annotations library folder.  Go to the Annotate tab and 
choosing the Tag drop-down panel name, then selecting the Loaded Tags option. 

 

Assign the tag to the Pipes/Pipe Placeholders category. 

 

 

Fill	Patterns	/	Hatches	
 

Fill Patterns are the equivalent feature to Hatches in AutoCAD and work very similarly.  A major 
difference between Revit and AutoCAD is that there are 2 different types of fill patterns in Revit, 
versus one type in AutoCAD.  The 2 different types are Model and Drafting. 

 Model patterns represent the actual size of items, such as brick in elevation, tiles, ceiling 
grid, siding in elevation, etc.  They are defined using actual sizes of the items that are 
represented and will show the actual size regardless of the view scale.  Therefore, 
pattern lines will print closer together at 1/8”=1’-0” scale than at ¼”=1’-0” scale since 
they maintain the actual real life distance between the lines. 

 Drafting patterns symbolically represent information, such as earth, concrete, brick in 
section, steel in section, etc.  Linework representing an item in drafting patterns will 
remain the same printed distance apart regardless of the view scale.  These patterns will 
have distances defined at a 1:1 printed scale.  If the user desires the lines to print 1/16” 
apart, then the pattern definition will specify that 1/16” dimension. 
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Some other differences between Revit fill patterns and AutoCAD hatches are: 

 The OOTB Revit fill patterns are stored in the revit.pat and revit metric.pat files.  Both 
can be found in the Data directory.  For a Revit Architecture 2013 default installation to 
the local computer, they are in the following folder: 

o C:\Program Files\Autodesk\Revit Architecture 2013\Program\Data 
 When a pattern has been imported, it is stored in the project.  It is now independent of 

the original .pat file from which the pattern came. 
 When naming a fill pattern, Revit allows you to include spaces in the name whereas 

AutoCAD does not allow spaces in the hatch name. 
 Revit allows you to define multiple fill patterns in one pattern file, but AutoCAD only 

allows one hatch per custom file. 

Converting	AutoCAD	Hatch	to	Revit	Fill	Pattern	
An existing AutoCAD Hatch can easily be modified to work with Revit by making a simple 
addition to the hatch text file. 

 Open the AutoCAD hatch pattern text file in a text editor program like Notepad. 
 Add a new line under the hatch description and before the hatch definition.  (The 

description line begins with an asterisk [*].) 
 The new line will have one of the 2 following lines of text added. 

o ;%TYPE=MODEL 
o ;%TYPE=DRAFTING 

 Save the file and it can now be loaded into Revit. 

The following illustrates a Model fill pattern on the left and a Drafting fill pattern on the right: 

 

Users may also copy hatch definitions from within AutoCAD hatch text files and paste them into 
Revit fill pattern files.  When doing this, the above line of text must also be added to the 
definition for it to work within Revit. 

Some considerations for accessing fill patterns include: 

 Your project template file should contain any routinely utilized fill patterns. 
 Keep the default Revit .pat and Revit Metric.pat files as strictly OOTB fill patterns. 
 Have a company fill pattern file that contains any custom fill patterns that you might need 

so that they are easily modified or duplicated for similar fill patterns. 
 A project file can be created that contains the custom fill patterns in filled region 

rectangles and labeled for easy reference.  When a custom fill pattern is needed, this file 
can be opened and the user can copy the desired fill pattern to the clipboard so that they 
can paste it into the desired project file. 
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Creating	Complex	Fill	Patterns	
There are a couple of Add-Ins for Revit that make it easier to create new complex hatches 
inside Revit.  These are: 

 Hatch22 – free Revit add-in from 3d Architectural Rendering and Animation Services - 
http://mertens3d.com/ 

 Cadro hatchkit - http://www.hatchkit.com.au/ - $125 – creates hatches/fills for multiple 
software packages other than just Revit. 

Materials	
Autodesk now uses a Material library that is 
shared among various Autodesk products, 
including Revit and AutoCAD.  Because of 
that, you may not need to do much of anything 
to utilize your AutoCAD materials in Revit.  
However, many AutoCAD don’t really utilize 
the materials very much so there are a couple 
of material graphic aspects that may need to 
be made to get them to look the way that you 
desire. 

The Surface Pattern and the Cut Pattern 
may need modified to utilize the fill (hatch) 
pattern to which you are accustomed.  When 
you select the Materials command from the 
Manage tab, you will want to locate the 
desired material and double-click on it to 
modify it. The patterns can be modified in the 
Graphics Properties portion of the Material 
Editor dialog box. 

The Surface Pattern is the fill (hatch) pattern 
that is seen in a view looking straight at the 
material, such as an elevation view.  The Cut 
Pattern is the fill pattern seen when the 
material is cut, such as in plan view or section 
view. 

The image on the right shows the Concrete 
Masonry Units material. 
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Annotation	
Revit utilizes Text Types, which are similar to Text Styles in AutoCAD.  Similar to AutoCAD’s 
newer Annotative text styles, all of Revit’s annotation is annotative which means that the text 
automatically adjusts size according to the view scale.  The text type will specify the desired 
height of the text when viewed on a printed sheet.  For instance, 3/32”, 1/8”, 1/4” text heights 
are commonly seen. 

The Revit templates contain 2 text types by default.  These are 3/32” Arial and 1/4” Arial, 
which will print at 3/32” height and 1/4" height respectively.  Their settings are shown below: 

 

Your firm will likely need to create additional text types to provide more flexibility within projects.  
It is not good to have users creating new text types on the fly, so the project template should 
contain a variety of standard text types that will be used on projects. 

There	are	a	few	key	items	to	consider	with	a	text	type.	

Naming	
When naming text types, it is good to think like a user and give the text type a name that is 
obvious as to its usage.  Some examples are: 

 General Text – Arrow 
 General Text – Dot 
 Legend Text 
 Legend Titles 
 Keynote Text 
 Cover Sheet Notes 

The big point is that you do not want the users not knowing which text type to use for a specific 
situation and feeling that they need to create their own text types.  You want consistency 
throughout your project files and details that will get shared between projects. 
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Settings	
While there are several settings within a text type, the following are significant: 

 Background – this determines whether model or detail information (like linework or fill 
patterns) are visible when text is placed over the information. 

o Opaque – background information WILL NOT be seen 
o Transparent – background information WILL be seen 

 Leader Arrowhead – this determines what symbol is shown at the end of the leader, if 
one is specified. 

o The list that appears here is determined by the Arrowheads that are specified in 
the project via the Manage tab -> Settings panel -> Additional Settings button  
-> Arrowheads option. 

o Additional Arrow Styles cannot be added. 
 Text Font – this determines the font that will be used in the text 

o Revit utilizes True Type fonts that are installed in the Windows Fonts folder. 
o While it may be tempting to attempt to use an AutoCAD font to make the 

drawings look like the AutoCAD files of the past, it is best to move forward and 
not try to directly replicate the old AutoCAD text appearance. 

o Arial is the most commonly used font for text in Revit. 
 Text Size – this determines the actual printed height of the text. 
 Width Factor – this setting is similar to the Text Width variable in AutoCAD and 

specifies how much the text is compacted. 
o A width factor of .9 is often used for general text and notes to enable the notes to 

utilize less space on a view. 
 Color – The text string can be set to a specific color to match what was done in 

AutoCAD, if desired. 
o Different text functions can be given different colors. 
o This color cannot be adjusted through use of View Filters. 

As a side note associated with text, when an AutoCAD drawing is imported or linked into Revit it 
can have the AutoCAD text fonts mapped to True Type font so that the AutoCAD text will 
appear like the Revit text.  You can edit the shxfontmap.txt file in Revit’s installation folder 
(Data subfolder) to map SHX fonts to Windows fonts. 

 The format of the mapping line is: filename.shx<tab>Fontname 

 

Dimensions	
While Revit does not have anywhere near the number of variables associated with dimensions 
as AutoCAD, there are still several parameters that define the appearance of a Revit dimension.  
In addition to the same settings that are important to text being important to dimensions, the 
following parameters are some to which special attention should be paid: 

 Dimension String Type – this sets the type to be “Continuous”, “Baseline”, or 
“Ordinate”. 

o These are separate types of dimensions in AutoCAD. 



Migrating AutoCAD Standards to Revit 

16 

 Tick Mark - this determines what symbol is displayed at the extension lines. 
o The list that appears here is determined by the Arrowheads that are specified in 

the project via the Manage tab -> Settings panel -> Additional Settings button  
-> Arrowheads option. 

o Additional Arrow Styles cannot be added. 
 Line Weight – this determines the thickness of the dimension line and uses the Line 

Weights specified in the project file. 
 Tick Mark Line Weight -  this determines the thickness of the tick marks (or 

arrowheads) and uses the Line Weights specified in the project file 
 Witness Line parameters – These are the same as “Extension Lines” in AutoCAD. 
 Color – The entire dimension string can be set to a specific color to match what was 

done in AutoCAD, if desired. 
o At this time, different parts of a dimension cannot have different colors as allowed 

in AutoCAD. 
 Dimension Line Snap Distance – this sets the distance between dimension strings. 

o This does not automatically place the string this distance apart, but snaps to the 
distance and typically displays a green dashed line when at the specified 
distance. 

 Equality Text - this specifies how you want the text to appear when specifying the 
Equality Text for a specify dimension string.  “EQ” is the default. 

Modifying	Elevation	Marker	Appearance	
The default building elevation marker included with Revit shows a square box 
with an arrow pointing toward the desired elevation.  The square box seems to 
rarely match existing company standards and companies often want to 
change this to be round and match their existing elevation markers.  

One of the OOTB markers included in the library but not in the default 
templates is the “Elevation Mark Body_NCS.rfa” family.  This marker is 
similar to one that many companies utilize and is based on the National CAD 
Standards. 

Process	to	change	square	marker	to	NCS	marker:	
 Go to the Insert tab and select the Load Family command from the Load from Library 

panel.  Select the “Elevation Mark Body_NCS.rfa” file from the Annotations library 
folder. 

 Go to the Manage tab and from the Settings panel select the Additional Settings 
button.  From the flyout, select the Elevation Tags option. 

 Select the ½” Circle type option at the top of the dialog box to change the elevation 
marker from being a square to a circle. 

o If this circle option is desirable, then no more steps need to be completed to use 
this option. 

 To change the elevation mark to the NCS symbol, pick the dropdown arrow to the right 
of the Elevation Mark parameter.  Select the option as shown below. 
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 Pick the OK button 
 Go to a floor plan view and select a Building Elevation marker. (Select the triangle and 

not the square portion.) 
 Go to the Properties dialog box and pick the Edit Type button. 
 In the Type Properties dialog box, go to right of the Elevation Tag parameter and pick 

on the ½” Square text.  When the button appears to the right, pick on it and then select 
the ½” Circle type listed at the top. 

 
  Pick the OK buttons to apply this option to all of the Building Elevation markers.  

Process	to	change	elevation	marker	arrow:	
It may be desired to have a different appearance for the arrow portion of the elevation marker. 

 In the Project Browser, go to the Families section and under the Annotation Symbols 
category highlight the Elevation Mark Body_NCS option.  Right-click and select the 
Edit option to open the pointer arrow in the Family Editor. 

 
 Add a Label in top half of the bubble and set the variables as shown in the following 

illustration.  Use the parameter named Detail Number. 
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 In the Project Browser, go to the Families section and under the Annotation Symbols 

category highlight the Elevation Mark Pointer_NCS option.  Right-click and select the 
Edit option to open the pointer arrow in the Family Editor. 

 
 Edit the filled region sketch to have your desired appearance and then pick the Finish 

button. 
 Delete the label that has the number “1” text. 

o This represents the Detail Number parameter for the view. 
o This is done so that the detail number on the sheet is not shown outside the 

bubble. 
 Load the revised Elevation Mark Pointer_NCS family into the Elevation Mark 

Body_NCS file to update the marker.  (Choose the “Overwrite the existing version and 
its parameter values” option.) 

 Load the revised Elevation Mark Body_NCS family into the project file to update the 
marker. 

 The following illustration shows a revised version of the Elevation Mark Pointer_NCS 
family with the elevation marker. 

 

It is advisable to rename the elevation marker family components to a different name to 
avoid overwriting your modified version with the OOTB version in the future. 
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Transfer	Project	Standards	
Most of the information that we have been discussing is stored in the project file.  This 
information can be transferred to other project files through the use of the Transfer Project 
Standards function available from the Settings panel on the Manage tab. 

Setting	Up	Views	to	Match	AutoCAD	
By default, Revit views are set to be black linework and text on a white background to match the 
printed sheet.  If you desire to have different information display as different colors similar to 
your current process, it is possible to largely get what you desire. 

Revit does not have layers like AutoCAD, but it does utilize Object Styles that can have their 
appearance vary per view or on a project-wide basis.  Due to plotting issues, I recommend 
using View Templates to create views that use colors when you desire, but also have the ability 
to print with halftones. 

Create	a	View	Template	for	Colored	Views	
On the View tab, select the View Templates dropdown on the Graphics panel, then select the 
Manage View Templates option.  Highlight the Architectural Plan view template (or similar 
floor plan view template if you have already created custom templates) and pick the Duplicate 
button at the lower left corner of the dialog box.  In the New View Template dialog box, type in 
a name such as Colored Floor Plan and pick OK.  With the new Colored Floor Plan view 
template name highlighted in the left pane, remove the checkmark from all parameters in the 
right pane, except for V/G Overrides Model and V/G Overrides Annotation. 
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The following steps show how to adjust the color for specific objects in your model. 

Configuring	Walls	to	have	color	appearance	similar	to	AutoCAD	Architecture:	
Pick the Edit… button next to the V/G Overrides Model parameter.  In the Visibility/Graphics 
Overrides for Colored Floor Plan dialog box, expand Walls and change the colors as desired.  
The Line Color for the general “Walls” category will affect the “shrinkwrap” of the wall.  The 
Line Color for the “Common Edges” subcategory will affect the interior linework of the wall. 

The fill pattern (hatch) of the wall is determined by the material assigned to the wall and is not 
specified in the Object Styles dialog box.  To change the fill pattern color, go to the Manage tab 
and select the Materials function from the Settings panel.  Double-click on the desired material 
and go to the Graphics Properties portion of the Material Editor dialog box to change the 
color (or fill pattern).  

The following image illustrates the values controlling different aspects of an OOTB AutoCAD 
Architecture wall. 

 

	

Configuring	Windows	to	have	color	appearance	similar	to	AutoCAD	
Architecture:	
Configuring window subcategories is similar to the process used for walls.  The following image 
illustrates the values controlling different aspects of an OOTB AutoCAD Architecture window: 
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The above examples demonstrate setting the default object style appearance for all instances 
within the project file.  To change the object style appearance for specific views, go into the 
specific view and type “VG” or “VV” to access the Visibility/Graphics Override dialog box for 
that view.  The desired appearances can be changed in this dialog box for this view similar to 
how they are changed on a project-wide status. 

 

Print	Color	
In AutoCAD the CTB or STB files specified whether the lines would be plotted in color, black, or 
grayscales.  In Revit, that is determined at the time of plotting.  Issue the Print command from 
the Application Menu, Ctrl+P, or another method.  In the Print dialog box, select the Setup… 
button in the lower right corner of the dialog box.  In the Print Setup dialog box that opens, go 
to the Appearance section in the lower right area and select the dropdown list under the Colors 
option.  Select the desired method of either printing with Black Lines, Grayscale, or Color. 

 

Note:  If you are using color in your views, you can print the color as all grayscale or all black, 
but not a combination. If you print as all black, you will not be able to halftone any objects such 
as demolition, underlays, or any other grayed linework.  Objects that have been set to be 
“Halftone” in the Visibility Graphics dialog will continue to be halftone on the print. 
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Migrating	AutoCAD	Details	to	Revit	
CAD users who have used AutoCAD for years have typically developed a large detail library, or 
at least have a lot of details used on previous AutoCAD projects.  Those details are valuable as 
a lot of time and knowledge has gone into developing them.  It is important to be able to access 
those details for usage within Revit. 

While there are various methods utilized for re-using AutoCAD details, not all of them are good 
solutions and some can add corruption to your Revit file and create problems. 

The best long-term solution for re-using AutoCAD details is to migrate the details into Revit 
native entities.  While inserting and then exploding details is a common practice, it creates 
residual information in the file and requires time and effort to clean up. 

The recommended practice to migrate AutoCAD details to Revit is basically a 3-step process: 

1. Link the AutoCAD detail into Revit; 
2. Trace the AutoCAD linework with Revit tools to create native Revit elements; 
3. Remove linked AutoCAD detail 

Link	the	AutoCAD	Detail	into	Revit	
 Create a new Drafting View from the View tab and the Create panel.  Name the view 

per your company’s naming standards and specific to the detail that you will create.  Set 
the scale appropriate to the detail. 

 On the Insert tab, select the Link CAD function from the Link panel.  Select the desired 
AutoCAD detail and select positioning to be “Auto – Center to Center”. 

 

Trace	the	AutoCAD	Detail	with	Native	Revit	Entities	
 You do not actually need to trace the lines of the linked file, as that can make the 

process take longer.  Instead, go to the Annotate tab and start the Detail Line 
command from the Detail panel.  Select one of the Line Styles and then select the 
“Pick Lines” option on the Draw panel. 
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 Proceed to select all of the lines that will use that particular line style.  Next, select 

another line style and proceed to select all of the lines that use that particular line style.  
Repeat for each of the desired line styles. 

o This process is much faster than actually tracing linework. 
o The AutoCAD link can be temporarily unloaded to see the Revit linework and 

verify that desired linework has been replicated. 
o Instead of using some of the linework, it can be better to utilize Detail 

Components where applicable, especially for items like angles, beams and other 
complex entities. 

 After getting the linework recreated, proceed to add the appropriate Revit fill patterns to 
the detail. 

o AutoCAD hatch patterns do not come through as Revit fill patterns, so any of 
those would need to be recreated as Revit fill patterns anyway if the detail were 
inserted and exploded. 

o This will create consistency throughout your projects by using your standard 
Revit fill patterns. 

 Add text as appropriate to the detail using your company standard Revit text types. 
o If the AutoCAD detail was exploded, the text would not be the same text types as 

is used in the rest of the Revit project.  Inserting the AutoCAD drawing adds the 
AutoCAD text styles as additional text types in the Revit project. 

 Add dimensions as appropriate to the detail. 
o If the AutoCAD detail was exploded, the dimensions would need to be recreated 

in Revit due to the AutoCAD dimension being lines and not true dimensions. 

Remove	the	Linked	AutoCAD	Drawing	File	
 Go to the Insert tab and select the Manage Links function from the Link panel. 
 In the Manage Links dialog box, go to the CAD Formats tab and highlight the 

appropriate AutoCAD file name.  Pick the Remove button at the bottom of the dialog 
box. 

 The AutoCAD file is no longer associated with this Revit project. 

This process creates a detail that now utilizes all native Revit entities and does not leave any 
AutoCAD entities in the Revit project file.  This detail can now be used in any other project file 
and/or saved out to a detail library. 

 To save the detail out to a library as an individual Revit detail file, highlight the drafting 
view detail name in the Project Browser, right-click, and select “Save to New File” from 
the context-sensitive menu.  Save the view as a file in the desired location. 

 The detail can also be copied into another project file by opening the other project and in 
that file go to the Insert tab.  Select the Insert from File button and the “Insert Views 
from File” option.  This allows you to insert a view from any other project file, so the 
desired detail drafting view can be selected for import. 
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Migrating	Company	Title	Block	
Your company title block is one of the first families that your company will want to migrate to 
Revit.  While the inclination is to just start with one of the OOTB title blocks, erase all of the 
information, and insert your AutoCAD title block, don’t do this.  Since your title block is used on 
pretty much every project that your company will do, it is best to create this with native Revit 
entities. 

Create a new title block family by going to the Application menu and selecting the New flyout, 
then Title Block.  In the New Title Block – Select Template File dialog box, select your 
desired title block size. 

At this point, it is easiest to link (not insert) your AutoCAD title block into this view with the 
process described earlier in the migrating details portion.  Proceed to create Revit linework to 
duplicate the linked AutoCAD title block.  After you are finished replicating the AutoCAD title 
block appearance, be sure and remove the AutoCAD linked file. 

Adding	Annotation	
Text that will be consistent for every instance of the title block on each project in your company 
should utilize the Text command. 

Text that will vary should utilize Labels.  Labels are intelligent pieces of text that get their values 
from parameters that are in the project.  Typical parameters that are used in title blocks include, 
but are not limited to: 

 Project Name 
 Project Address 
 Project Number 
 Sheet Name 
 Sheet Number 

While Labels can be set up to appear exactly like the text in the file, they utilize different types 
so you must create Label Types similarly to the process used for Text Types. 

Adding	a	Revision	Schedule	
Since most title blocks have a revision schedule area, you will want to add the automated 
Revision Schedule included in Revit.   This is selected from the Create panel of the View tab. 

The Revision Schedule is created similar to other schedules in Revit.  Since this will appear on 
every sheet using the title block, the Appearance tab is important to get it organized in the way 
you desire. 
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Note that the schedule may expand with the new revision above the previous revision (buttom-
up) or the new revision below the previous revision (top-down).  If you want to create all of the 
linework in the schedule prior to the actual revisions being in existence, you will need to change 
the following: 

 Grid lines will need to have the default checkmark removed. 
 Outline should not have a checkmark. 
 The distance between the actual linework is determined by the text height that is 

specified, so you will need to determine the actual spacing required by Revit and use 
that distance instead of the distance that you used in AutoCAD. 

If the Height option is specified as Variable, then lines in the schedule will only appear when a 
revision exists for that line to be needed to create a row.  The distance to that line will be 
determined by the number of lines of text in the revision Description field. 

If the Height option is specified as User Defined, with Grid Lines turned on, then the lines will 
always show in the title block.  The round grip can be adjusted to shown the desired number of 
row lines. 

 

Revision Schedules may be rotated 90 degrees on the title block via the Rotation on Sheet 
option on the Options Bar. 
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Configuring	Revision	Standards	
Companies typically track revisions in one of two ways.  They either have the revision number 
based on the project so the revision number only appears once on a project, or they have the 
revision number based on the sheet so that each sheet will have its own revision number 1.  
Revit allows you to do either way, so this needs to be configured. 

The Revision settings inside Revit are accessed from the 
Manage tab, then the Additional Settings function on the 
Settings panel.  In the upper right corner of the Sheet 
Issues/Revisions dialog box, select the desired revision 
numbering method.  

 

 

	

	

Conclusion	
As you move forward with implementing Revit, do not try to make Revit be AutoCAD.  Revit is 
based upon a single 3-dimensional building model using the same objects to create plans, 
elevations, and sections.  Adjustments to the design and documentation process need to 
change with this transition, so be patient as you change your workflow and thought process to 
work with Revit. 

 

 

 

 

 

 

Thank you for your interest in this class! 

 


